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LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY 

VAULTLOGIX MAKE’S NO REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY 
OR COMPLETENESS OF THE CONTENTS OF THIS MANUAL AND SPECIFICALLY DISCLAIMS ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  THERE 
ARE NO WARRANTIES WHICH EXTEND BEYOND THE DESCRIPTIONS CONTAINED IN THIS 
PARAGRAPH.  NO WARRANTY MAY BE CREATED OR EXTENDED BY ANY PARTY OR WITHIN ANY 
MARKETING MATERIALS.  THE ACCURACY AND COMPLETENESS OF THE INFORMATION PROVIDED 
HEREIN AND THE OPINIONS STATED HEREIN ARE NOT GUARANTEED OR WARRANTED TO 
PRODUCE ANY PARTICULAR RESULTS, AND THE ADVICE AND STRATEGIES CONTAINED HEREIN 
MAY NOT BE SUITABLE FOR EVERY INDIVIDUAL OR BUSINESS. VAULTLOGIX SHALL NOT BE 
LIABLE FOR ANY LOSS OF PROFIT OR OTHER COMMERCIAL DAMAGES, INCLUDING BUT NOT 
LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES. 



Checklist 
 
1. Have you registered the IV-Client with the VaultLogix server? Y N (see Registering the 

IV-Client with the VaultLogix server)  
Comments: 

     

 
 
2. Have you added your SMTP settings? Y N (see Configuring Client Email Notifications)  

Comments:       
 
3. Have you configured general client preferences? Y N (see Configuring Client Preferences) 

Comments:       
 

4. Have you configured templates? Y N (see Configuring Templates) 
Comments:       
 

5. Have you setup a scheduled backup? Y N (see Creating a Schedule) 
Comments:       
 

6. Have you reviewed retention rules for backup? Y N (see Retention Rules for Backup) 
Comments:       
 

7. Have you reviewed retention rules for archiving (if applicable)? Y N (see Retention Rules for 
Archival Purposes) 
Comments:       
 

8. Have you setup a MSSQL backup? Y N (see Running a MSSQL Backup) 
Comments:       
 

9. Have you setup a MS Exchange backup full or brick level backup? Y N (see Running a MS 
Exchange Backup) 
Comments:       

 
10. Have you reviewed how to perform a system state backup? Y N (see Running a System State 

Backup) 
Comments:       
 

11. Have you setup a Linux, MAC, etc… backup using SSH/SSL? Y N (see Running a Backup via 
FTP/SFTP/FTPS) 
Comments:       
 

12. Have you learned how to delete files from the online vault? Y N (see Deleting Online Vault 
Files) 
Comments:       
 

13. Have you learned how to delete a scheduled backup job? Y N (see Deleting a Scheduled 
Backup Job) 
Comments:       
 

14. Have you learned how to restore? Y N (see Restoring Backups) 
Comments:       

 
15. Have you learned how to restore from the archive server (if applicable)? Y N (see Restoring 

from an Archive Server) 
Comments:       
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16. Have you gone through the advanced restore options? Y N (see Advanced Restore Options) 
Comments:       
 

17. Have you learned how to perform an initial large backup to local disk? Y N (see Initial Large 
Backup to Local USB Disk)  
Comments:       
 

18. Have you learned how to span a large initial backup over X hours? Y N (see Spanning a Large 
Initial Backup) 
Comments:       
 

19. Have you registered a replication server (if applicable)? Y N (see Registering a Replication 
Server) 
Comments:       
 

20. Have you reviewed the client reporting? Y N (see Reports and Logs) 
Comments:       

 
21. Have you tested a backup with the IV-Client using a client that you setup in the web operator? Y 

N 
Comments:       

  
22. Have you read, and, re-read, the manuals and knowledge base and web site? Y N 

Comments:        
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VaultLogix IV-Client Pre-Installation Requirements  
 
Minimum System Requirements: 
 

1) Supported Operating Systems  
 
Platform Version 
Windows® 2000 Professional SP4 >, or 

Server SPP4 >, or  
Advanced Server SP4>  

Windows® XP Professional SP2>, or  
Media Center SP2>, or 

Windows® Vista Business SP1>, or 
Ultimate SP1>, or 
Enterprise SP1> 

Windows® 2003/2008/2008 R2  Standard SP1>, or  
Enterprise SP1 >, or  
SBS SP1 > 

Windows® 7  Professional >, or  
Enterprise >, or  
Ultimate  

 
2) Minimum Hardware Requirements  

 
For optimal performance, install the IV-Client on the best, name brand hardware that you can 
afford.  
 
Hardware x86, x64 (64 bit recommended)  
2 dual CPU  2.0GHZ > 
RAM <1M files 3GB > 

2M files + 4GB > 
Storage Requirements A minimum requirement of 1GB> of storage space 

is recommended but is purely based on usage 
patterns.  The more you backup the larger this 
local storage will grow. 
 
Note: A local copy of the data is NOT stored on 
the client unless the local storage component is 
enabled.    
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Document Revision History Table  
This table only lists major changes or additions  
 
Version/Date Notes 
8.0.1 ACL/ADS functions 

Local Storage 
Customer Encryption keys 
New Archive screens  
Customer management console  

8.0.1.1 Backup to local storage 
Advanced Exchange setup moved to Troubleshooting (not needed in 8.x) 
Retry/Cancel options added under Preferences  

8.0.1.3 Backing up Novell  
Restoring to a MS Exchange Recovery Group 

9.0.0.0 Thin Exchange  
Restore Command Line  
First Time Run Wizard  
Expanded on Logs 
Removed Client Side Replication  

9.0.3.0 Expanded on First Time Run Wizard  
Plug-in section added  

10.1.0  Brick level for 2007 (MAPI)  
MSSQL THIN Differential   
XML Logs  
Updated hardware requirements  
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Initial Setup and Configuration 

Installing the VaultLogix IV-Client  
 

1. Download and Double Click on the IV-Client executable  
2. Click Next  

 

 
 

3. Read through the License Agreement and Click I Agree to proceed 
4. Browse to the installation location or Click Next to use the default location 
5. Choose a start menu name and Click Install  
6. Click Next to complete the installation 
7. Click Finish to launch the IV-Client  
8. You will now be prompted with the First Time Run Wizard (FTRW).  The FTRW will allow you to 

easily configure the IV-Client with all the required information it needs to run.  To skip the 
FTRW, click Cancel and proceed to manually configuring the client, starting with Registering 
the VaultLogix IV-Client with the VaultLogix Server, below.  
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Registering the VaultLogix IV-Client with the VaultLogix Server   
 
Registering an account with the VaultLogix server is required so that backups and restores (remote and 
local) can be performed to the designated VaultLogix server.   
 

1. From the main menu, Click Tools and Click Add a backup server    
 

 
 

2. Enter the appropriate information below  
3. Click OK  

 

 
 
NOTE: This process can also be accomplished by using the First Time Run Wizard (FTRW).  The FTRW 
can also be accessed at any given time by clicking File> First time run wizard…  
 

4. Registering an account can also be done on the server selection screen (see Create a New 
Schedule)   
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Configuring Client Email Notifications (SMTP) 
 
With VaultLogix, you can receive email backup status reports per backup job.  Adding your SMTP server 
to the IV-Client is done via the main toolbar.  
 

1. Start > Programs > VaultLogix Internet Vault> VaultLogix Internet Vault 
2. Click on Tools  
3. Click on Manage SMTP servers  
4. Click Create  
5. Fill in the appropriate fields below  
6. If your server requires authentication, Check the My Server requires authentication box 
7. Add your username and password 
8. Click Add 

 

 
 

9. Click OK 
 

10. Done  
 
NOTE: This process can also be accomplished by using the First Time Run Wizard (FTRW).  The FTRW 
can also be accessed at any given time by clicking File> First time run wizard…  
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Configuring Client Preferences  
 
The VaultLogix Preferences menu, available from the toolbar, allows you to manage a wide variety of 
settings and preferences.   
 
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
1. Click on Tools 
2. Click on Preferences 

 
The top-level preference settings are General, Visual, Functionality, File Type, Security, Advanced, 
and Log.  The default screen is General Preferences. 
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General Preferences  
 
>>Enter the default location to store temporary files: This option allows you to set a default location 
(UNC, mapped drive or local machine) for temporary files. (see Does VaultLogix use temporary files 
during backup and restore)   
 

1. To select a temporary location, Click Browse and go to the desired location(s) to set the path 
2. Click OK 

 
>> Use the following page size when backing up files:  Page Size is the amount of RAM used to read 
the files to be backed up.  This gives you the opportunity to optimize your backups based on the RAM 
on the machine you have the IV-Client installed on.   
 
 

Note: 

The Page Size setting must be between 1260 bytes and 100 MB   

 
>> Enter the location to store local file information: Used to store a small amount of file information 
that is used to increase backup efficiency.  
 
>>Skip CRC & SHA calculation, if last modified date and file size has not changed: By default the IV-
Client will NOT calculate CRC/SHA hashes if a file’s modified data or file size has not changed.    
 
>> Threads for calculating CRC & SHA: Dictates the number of threads to be used when calculating 
file hashes.  
>> Threads for transferring files: Dictates the number of threads to be used when transferring files to 
the VaultLogix server.  
>> Threads for enumerating directories: Dictates the number of threads to be used when discovering 
the files to be backed up. 
  
Note: For more information on CRC & SHA hashes see, What are CRC & SHA hashes?  
 
>> Transfer speed (bytes per second): Transfer speed, also known as bandwidth throttling, allows you 
to limit the bandwidth that the IV-Client uses at backup time. 
  
 
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
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Visual Settings 
 
Visual settings allow you to set advanced visual settings such as keeping the backup window open after 
successful/unsuccessful backups or disabling the system tray icon during backup time.  
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
 
 
 

Functionality Settings  
 
>>Skip LAN loading for faster computer backup: Once the IV-Client is launched, it automatically 
searches your entire network for all networked machines.  To avoid this step upon launch, Click this 
option ON to instead load for a saved list of machines.  

  
>> Allow at most one backup to run at a time: Will NOT allow concurrent backup jobs to run.  
 
>> Do not calculate backup size: This refers to stopping the process of calculating the total size of the 
files that you have selected to backup in the file tree window.   
 
>>Delete PST files after brick-level exchange backup:  When restoring a brick level exchange (mail 
box level), VaultLogix first restores the PST files and then uses the EXMERGE utility to insert them into 
the Exchange database.  
 
>>Force LAN loading when backup starts from scratch: If you want the IV-Client to check for new 
computers that have been added to your LAN each time a backup starts from scratch, select the Force 
LAN Loading option. 
 
>>Allow computer to enter a suspended state while backups are running:  By default the VaultLogix 
IV-Client will not allow a computer to enter sleep mode while running a backup.   
 
>>Connection lost settings: In the case of a loss of connectivity to the Internet, the IV-Client will 
attempt to automatically reconnect a backup job ten times, with a 60 second time interval in between 
of each reconnect attempt, before automatically cancelling the job.  
 
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
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File Type Settings  
 
>> Backup files of size 0: By default the IV-Client will automatically backup files that are 0 bytes in 
size. 
 
>> Backup operating system files: By default the IV-Client does backup operating system files  
 
>>Backup read only files: By defaults the IV-Client does backup files that are marked as, READ ONLY.  
 
>> Backup temporary files: By default the IV-Client does backup temporary files  
 
>> Backup hidden files: By default the IV-Client does backup hidden files.   
Note: By default templates WILL search through hidden files even if this option is checked to OFF. (See 
Templates for more information)   
 
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
 
 

 Security 
 
>>Enable authentication when opening the backup client: The IV-Client has built in security to 
protect your data from unauthorized access.  To enable authentication, Check on Enable 
Authentication and enter in a username/password.  
 
>>Use a randomly generated encryption key: By default an encryption key is generated randomly for 
each block of data. An account is authorized to certain keys if it has the block in one of its backup set 
versions. This allows you to change your username/password at any time, as your encryption key is not 
in any way linked to the password. 
 
>>Use a specific customer encryption key: A customer encryption key is usually used by corporate 
clients that want a user generated encryption key to be used by their entire organization when backing 
up to a Managed Service Provider.   
NOTE: This user generated customer encryption key will be REQUIRED at the time of restore.  Without 
it, the data will NOT be able to be restored.  
 
>>Use a specific customer and user encryption key: A customer/user encryption key is usually used 
by corporate clients that want not only a customer encryption key for their entire organization but also 
a secondary, per location encryption key when backing up to a Managed Service Provider.   
NOTE: These user generated customer/user encryption keys will be REQUIRED at the time of restore.  
Without them, the data will NOT be able to be restored.  
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Advanced Settings 
 
>>Enter a file path to an application you would like to start before backup: The IV-Client enables 
you to automatically run a service or script before running a backup job.     
 
>>Enter a file path to an application you would like to start after backup operations: The IV-Client 
enables you to automatically run a service or script after a backup job has ran.     
 
>> CPU throttling: Allows you choose how much processing power you want to dedicate to running your 
backups. 
 
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
 
 
 
Log Settings   
 
 
Log settings gives you advanced log settings such as the store location of logs and enabling certain 
module logging (FTP, SMTP).   

 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal  
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Configuring Templates   
 
Templates allow you to quickly backup all your mission critical data by file type no matter of its 
physical location on your network or remote machines.  

Creating a Template  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault. 
2. Click on Manage Templates 
3. Click Create 

 

 
 
 

4. Type a name for the template then add the files types you want associated with the template.  
5. When finished, click Save.  Your template is now available for use in backup jobs.  
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Editing Existing Templates  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Manage Templates 
3. Select the Template you wish to modify 
4. Click the Modify button 
 

 
 

5. Modify the Template of your choice by adding or removing file types from it 
 
 

Note: 

 
Editing a template will affect all existing backups associated with the 
template. 

 
6. When finished, click Save.  Your template is now available for use in backup jobs.  
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Secondary Setup  
 

Adding a Networked Computer  
 
Internet Vault’s agentless structure simplifies the process of adding new networked computers to your 
VaultLogix backup strategy. 
 
NOTE: Internet Vault will automatically discover all networked machines on your LAN that can be seen 
by Windows® unless otherwise specified under Preferences (See Preferences).  This feature is used to 
manually discover machines that don’t appear in your Internet Vault file tree and can include 
Windows®, Linux or MAC machines.  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools 
3. Click on Add a networked computer 
4. Enter the machine’s UNC path 
5. Enter your user name and password 
6. Click Add 
 

Definition: 

 
UNC stands for Universal Naming Convention.  UNC names consist of three parts: the 
server name; a share name, and an optional file path. These are combined using 
backslashes as follows  

\\server\share\file_path 

 

 
7. Done  
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Setting up Client Side Encryption Keys  
By default, an encryption key is generated randomly for each block of data. An account is authorized to 
certain keys if it has the block in one of its backup set versions. This allows you to change your 
username/password at any time, as your encryption key is not in any way linked to the password. 

Alternatively, you are free to add customer encryption key or a user encryption key, or both that only 
you will know.  These client side key(s) will be REQUIRED at restore time.  Without these keys, the 
data will NOT be recoverable.    

Note: To review client side encryption keys in detail, see Preferences> Security above. 
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Adding an MS SQL Server  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule 
3. Type in a unique backup name 
4. Choose MSSQL Backup 
5. Click Next 
6. Click ADD  
7. Choose your preferred connection method (TCP/IP or Named Pipe) and fill in the associated 

information.  Click Add to continue    
 

 
 
 

Definitions: 

Server Name: The name of the SQL server or IP address you wish to connect to and backup 
 
Port: The actual port the SQL server is running on.  (TCP/IP needs to be enabled on the SQL server)  
 
Pipe name: A common SQL connection method. (SQL Pipe needs to be enabled on the SQL server)  
 
Windows authentication: A standard Microsoft authentication protocol  
 
SQL Server authentication:  
Username: A user account that has access to the SQL Server 
 
Password: The password that is associated with the username name that has access to the SQL Server 

 
 

8. Done 
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Using Templates  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault. 
2. Click on Create a New Schedule 
3. Enter a unique name for the backup job 
4. Choose File Backup  
5. Specify the computers/drives that you wish to apply the template backup to  

 
 

 
 
 

6. Since a template applies to this backup, Click either Backup files matching template only to 
backup only those files in your chosen template, or Backup all files except those matching 
template to backup everything except those files in your chosen template.  
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Note: 

 
Internet Vault powered templates will search throughout a specified location and locate and backup all 
files matching the template no matter if they’re hidden or not.   

 
7. On the Templates screen, Click the template(s) to use, then Click Add selected to add them to 

the backup job. 
8. Once you’re done with your template selections, Click Next and proceed with the rest of the 

Creating a New Schedule process (see Creating a New Schedule)  
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Adding an FTP/SFTP/FTPS server  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools 
3. Click on Manage FTP, SFTP, FTPS servers 
4. Click Create 
5. Fill out the information below  
6. Click Add 

 

 
 
 
 

 

Definitions: 

Friendly Name:  A name given by the user for a specific FTP server so they know what the path represents later.  
For example, instead of later seeing a default of, say, ftp.VaultLogix.com, you would see ‘VaultLogix Primary FTP 
Server’.  This provides more user-friendly information for the end user. 
 
Passive FTP: Using passive FTP, a PASV command is sent instead of a PORT command. Instead of specifying a port 
that the server can send to, the PASV command asks the server to specify a port it wishes to use for the Data 
Channel connection. If passive FTP is not checked, the client connects from a random unprivileged port (N > 1024) 
to the FTP server's command port, port 21 

 
7. Click OK 
8. Click Exit 
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Editing a FTP/SFTP/FTPS Server  
 
1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools 
3. Click on Manage FTP, SFTP, FTPS servers 
4. Select the desired server 
5. Click Modify 

 

 
 

6. Make the appropriate changes 
7. Click Save 

 

 
 

8. Click OK 
9. Click Exit 
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Deleting a FTP/SFTP/FTPS Server  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools 
3. Click on Manage FTP, SFTP, FTPS servers 
4. Select the desired server 
5. Click Delete 

 

 
 
 

6. Click Yes 
7. Click OK 
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Plug-ins  
Internet Vault was designed from the ground up with expandability in mind.  This expandability is 
accomplished through our robust plug-in infrastructure.  A plug-in allows any software developer to 
enhance the functionality of the Internet Vault system by enabling new backup functions by creating a 
plug in for it.  A plug-in can easily be added to the VaultLogix IV-Client through the VaultLogix 
Customization Kit or via double clicking a self extracting Plug-in (.exe).  
 
For a complete list of plug-ins with descriptions, please see the Knowledge Base under your VaultLogix 
customer portal.   
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Open Document Manager – Open File Management  
ODM is a robust open file utility that seamlessly gives Internet Vault the power to backup any open, 
locked or in-use files, ensuring that your business will run without interruption twenty four hours day, 
seven days a week. 
 
The ODM installation is simple and easy to do.  To use ODM, follow the below: 
 

1. Download the ODM software  
2. Double Click the installer file and proceed with the installation using the onscreen instructions 
3. Done 

 
Note: A reboot is NOT required unless you want to backup system files that Windows would have locked 
before the ODM installation took place 
 
Note2: A ODM software installation is required on the host machine (where the VaultLogix IV-Client is 
installed) and on any networked target machines where you want to backup open or locked files from.  
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Backup Scheduler  
 
The VaultLogix System Scheduler runs based on the schedules you setup.  These system tools are run 
via a windows service named BackupScheduler.  
The BackupScheduler service itself should always be run as the local system account. The local system 
account has certain privileges that are needed to properly run schedules throughout your system.  
 
Schedules should always run:  
- Schedules will run whether you are logged in, or logged off of the computer.  
- Schedules will run if the computer is locked.  
- Schedules will run if the computer is asleep.  
 
Authentication information is important for many reasons:  
- Authentication information is needed since the user you specify might be the only account with the 
proper permissions to perform certain tasks.  
- Authentication information is needed since the user you specify might have a mapped drive 
associated with their account.  
- Authentication information is needed because if none is specified, the scheduler will run as the local 
system account user.  This account does not have access to the network at all.  
-Windows Vista and later requires authentication  
 
If there is no authentication information specified, your scheduler will still run, but Windows will not 
allow the scheduler to access network resources.  
 
The BackupScheduler works in the following way:  
1) Try to find a session that is running with the specified user.  If one is found, run the scheduler in 
that user's session.  
2) If no session is found with the specified user, perform a logon operation.  The window will be visible 
when you logon. 
3) If no authentication information was specified in Windows Vista the scheduler will not work  
3.1) If prior to Windows Vista: The scheduler will be visible when you logon. 
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Creating a Schedule  
Creating a backup schedule is performed from the Create a New Schedule function available on the 
Main Menu. 
 
To setup a Schedule, see Creating a Backup Set 
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Editing a Schedules Run Time  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools 
3. Click on Schedule Management  
4. Select the backup job to edit 
5. Click Modify Schedule 

 

 
 
 

6. Make any necessary changes  
7. Click OK when you’re finished 
8. Done 
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Deleting a Scheduled Backup Job  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Tools> Schedule Management 
3. Select the backup job to delete 

 

 
 
 

4. Click Yes to delete the profile 
5. Done  
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Retention Rules 
 
Retention Rules for Backup   
Setting retention rules for backup allows you to define the number of generations of a particular 
backup job to keep on your offsite server.   
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule  
3. At the Server selection screen, accept the default of (10) file generations or adjust it to the 

number you’d prefer.  Click Next to proceed with the backup.  
 
 

  
 
 

Note: 

 
Setting the number of generations to 0 translates to an unlimited number of file versions 
being kept offsite on the Internet Vault server or locally depending on the type of set you 
created. 
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Creating and Modifying a Backup Set  

Creating a Backup Set  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule 
3. Choose the backup type and give the job a name  
4. Click Next 
5. Choose any file(s) and folder(s) to be backed up throughout your network  
6. Add any appropriate template (Optional.  For more details, see Configuring Templates and 

Using Templates) 
7. Click Next 

 

 
 

8. Click Backup to remote server (no local storage) (see Running a Backup to Local Storage to 
use the other option) 

9. Choose or add the backup server to be used for this backup  (See Registering an IV-Client with 
the VaultLogix server) 

10. Set your transfer, encryption, ACL’s and Alternate Data Streams options (See Advanced Backup 
Settings) 
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11. Note: If you choose to run a large initial backup to local storage, browse and select the storage 
location to use. (See Advanced Backup Settings – Initial Large Backup to Local Disk) 

 
12. If you choose to span a large initial backup overall several days see, Spanning a Large Initial 

Backup   
 

13. Click Next  
 

 
 
 
 

Note: 

After the “first initial backup to local storage” is complete, all subsequent backups of this 
same profile will be automatically transferred to the offsite server via the Internet, 
independent of the initial backup’s physical importation into the offsite server.  The local 
drive must be physically shipped by courier to the offsite backup server for importation by its 
administrator. 
This feature saves time between the physical transportation of the local drive and the time it 
takes to import the backup into the offsite server. 

 
 

14. Click the desired Log file settings 
15. Choose the appropriate email settings (See Configuring Client Email Notification) 
16. Choose the schedules start time, effective date and frequency.  
17. Authentication is also available but not necessary to run LOCAL schedules. (See Advanced 

Backup Settings –Authentication for more information) 
 
NOTE: Authentication is REQUIRED when running a backup of a networked machine, UNC path or 
mapped drive.  

 
18. Click Finish 
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Modifying a Backup Set 
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Edit Backup Schedules 
3. Select the backup job you to edit  
4. Click Next 

 

 
 
 

5. Proceed editing the backup job in the same way you would when creating a backup job (See 
Creating a backup job)   
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 Running a THIN MSSQL backup  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule 
3. Click Run a New MS SQL Server Backup 
4. Click Next 

 
 

Note: 

IMPORTANT: Running your MS SQL backups from an IV-Client on a Win 2000 machine?  
In order to connect to a MS SQL database for an IV-Client running on a Windows 2000 Pro you will need 
to first download and install the Microsoft Data Access Components located at the following link: 
http://www.microsoft.com/downloads/thankyou.aspx?familyId=6a7d785f-c2e0-471d-a33b-
82ad1d514737&displayLang=en  

 
5. Click the SQL server(s) to backup and Click Refresh to list the associated databases  

 
NOTE: If you have no SQL servers added, see Adding a MSSQL Server 
 

6. Click the databases to backup  
7. Click Next 
8. Choose Thin differential or Thin full backup (for more information on Differential Backups, see 

our online FAQ’s)  
 

 
 
>>Backup auto discovered new databases at backup time: Click this option to automatically discover 
and backup new databases at backup time.  

 
9. Proceed with the backup as normal (see Creating a Backup Set)   
10. Done 
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Running a Thin MS Exchange 2000/2003/2007 Backup  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule  
3. Click Run a New Exchange 2000/2003 Backup 
4. Click Next 
5. Select MS Exchange database backup 
6. Click Next 

 

 
 
 

 
7. Enter your cluster or computer name and Click Next  
8. Choose the number of THIN and Full Restore Points of your choice (See What is a THIN 

Exchange Backup in the FAQ section of your VaultLogix Customer Portal)  
9. Proceed with the backup as normal (see Creating a Backup Set)   
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Running a MS Exchange 2003/2007 Mailbox (Brick Level) Backup 
 

1. To backup individual Exchange mailboxes, select Exchange brick-level backup 
2. Click Next 

 

Troubleshooting: 

 
Q.  When I click Next, I get the following error message: Please include the following path 
to your Environment variables: <exchange server folder> \bin 
 
A.  See Adding an Exchange Level Variable in our online Knowledge bas  

 
3. Fill in the fields below  
4. Specify a date range for the backup by enabling the function below (optional) 
5. Click Next 

 

 
 
Note: Depending how you are backing up your Exchange 2003/2007 Brick level, Microsoft requires 
that either Outlook 2003/2007 or the Exchange MAPI Client and Collaboration Data Objects 1.2.1 
are installed.  
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6. Select the mailbox(es) to backup 
7. Click Next 

 

 
 
 

8. Proceed with the backup as normal (see Creating a Backup Set)   
9. Done  
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Running a Local/Agentless System State/Active Directory Backup 
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule  
3. On the file selection screen, Click the System State plug-in icon under the local machine or on 

a networked machine   
 
 

 
 

4. Proceed with the backup as usual (see Creating a Backup Set)  
5. Done 

 
NOTE: System State backups are only supported on XP or above while Active Directory backups are only 
valid on Win 2003 server and above  
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Running a Backup via FTP/SFTP/FTPS (Windows, MAC, Linux, etc…)  
 
NOTE: See Adding an FTP/SFTP/FTPS server for registering remote machines.    
 

1. Run a backup as normal (see Creating a Backup Set)  
2. At the file selection tree expand the remote machine under FTP computers  

 
NOTE: To connect to the machine Click Not Connected (Click to Connect) (next to Status on the right 
hand side) and Enter an administrative username and password.  
 

 
 
 
 

3. Proceed with the backup as normal (see Creating a Backup Set) 
4. Done  
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Running a Backup to Local Storage   
 
Note: Running a Backup to Local Storage is different from running an initial large backup to USB.  Local 
storage allows you to keep a local copy of your data onsite for faster restore times in non critical 
situations while initial large backups to USB allow you to move large amounts of data by physically 
shipping the data via a USB disk to the server thus avoiding bandwidth bottlenecks.  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule  
3. Select the files to backup and Click Next  
4. Select Backup to local storage and sync to remote storage  
5. Select the appropriate offsite backup server  
6. Specify the number of generations to keep locally and how many generations to keep remotely  
7. Specify the frequency of the schedule for the replication function  
8. Specify your notifications  
9. Specify the frequency of the schedule for the local storage backup (if applicable)  
10. Done   

 
NOTE: To change the location of the local storage, go into the VaultLogix IV-Client, Click General 
Settings and change the path under “Enter the location to store local data”.   
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Running a Statistical Backup  

Statistical backup data can be generated to determine the data backup usage and trends before 
performing an actual backup. You will need to have registered your IV-Client with the VaultLogix server 
(see Registering an IV-Client with a VaultLogix server) as a connection will be made to determine 
which files will need to be transferred (see de-duplication), space used and total size of the backup 
set.  Statistical data is gathered and stored in a report (see Viewing Reports Listed by Backup Job). 

NOTE: You can not restore or convert a statistical backup to a true backup set.    

1. Proceed with Running a Backup until you reach the server selection screen (see Running a 
Backup)  

2. Choose Statistical Block Level Backup From the Method of transfer drop down menu   
 

 
 

 
 

3. Proceed with the backup as normal (see Creating a Backup Set)   
4. Done  
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Deleting Backup Jobs and Online Vault Files 
 
Deleting Online Vault Files 
  
To physically delete a backup profile from your online vault you must first mark it for deletion from 
your IV-Client.   
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup  
3. Choose from one of the listed restore options  
4. Click Next 
5. Click Delete selected Backup  
6. Done 

 
NOTE: To delete all backups from your online vault, Click Delete all Backups  
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Restoring Backups 
 

Restoring - Search a Specific Location for a List of Backups 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click Restore Backup 
3. Click Search a Specific location for a list of backups 
4. Click Next 

 

 
 

5. Select the VaultLogix server to restore from  
6. Click the + sign for the backup you’d like to restore 

 
 

 
 
 
 

7. Click the particular backup you’d like to restore 
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Note: 

Each backup will also have at least one backup date associated with it.  To restore a backup, you 
must not only select the backup, name, but the backup date as well. 

 
8. Specify the restore location for the backup  
9. Click Next 
10. Select the files to restore 
11. Choose the appropriate options (See Advanced Restore Options) 
12. Click Next 

 

 
 

13. Click Finish after the restore has run 
14. Done  
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Restoring- Search Specified Files on a VaultLogix Backup Server  
This quick restore option searches throughout all your backups by file name or extension.   
 

1. Click Restore Backup from the main menu  
2. Click Search Specified Files on a Bit Level Backup Server  
3. Choose the specific VaultLogix server and enter your search criteria 

 

 
 
NOTE: For example to search the server for all text files, type *.txt (VaultLogix is Regular Expressions 
friendly) and to find file(s) matching the word Accounting, enter Accounting.   
 

4. Select the file(s) and the restore location and Click Next  
 

 
 

5. Proceed with the restore process as normal (see Restoring - Search a Specific location for a 
list of backups) 

6. Done 
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Restoring a Generation of a Backup Profile  
 

1. Proceed with the restore as normal until you get to the below screen (see Restoring - Search a 
Specific location for a list of backups) 

2. Choose the generation to restore 
 
NOTE: It is NOT necessary to restore prior generations.  See below example for more detail.    
 
3. Click Specify a location to restore to 
4. Click Next  

 

 
 

5. Type in or Browse to the desired location 
6. Click OK 
7. Proceed with the restore as normal (see Restoring from a List of Known Backups)  
8. Done 

 
Restore Example:  
Day 1 - You backup a directory with 1000 files and name it Backup A  
Day 2 – Backup A runs again on the same directory with 1000 files and only backs up 50 of the files 
because they've changed (note: Internet Vault only backs up delta blocks that have changed as we 
perform common block elimination)  
Day 3 – You run Backup A once again and only 7 files have changed  
Day 4 - You want to restore the entire directory as it was on Day 3.  You would simply restore the 
generation that was created on Day 3 without having to first restore Day 1 and day 2. 
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Restoring a MSSQL 2000 Backup  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup 
3. Select Search a specific location for a list of backups  
4. Click Next 
5. Click the SQL backup you’d like to restore 

 

 
 

6. Click Specify a location to restore to 
7. Type in or browse to the desired restore location (e.g. C:\temp) 

 

Note: 

As the restored backup will have to be manually imported by SQL Enterprise Manager, it is 
not necessary to restore it to a “permanent” location. 

 
8. The SQL backup will be restored to the location you specified on the restore window  
9. Browse to the location specified by the restore window 
10. Click Start > Programs > Microsoft SQL Server > Enterprise Manager 
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11. Expand the Server 
 

 
 
 

12. Right Click the Database that you’d like to restore  
13. Click All Tasks 
14. Click Restore Database 
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15. Click From device 
16. Click Select Devices 

 
 

 
 

17. Click Add 
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18. Click Browse 
 

 
 

19. Browse to the location of your restored backup 
20. Click on the .db file 
21. Click OK 

 

 
 

22. Click OK again 
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23. Click OK again 
 

 
 

24. Click Restore backup set  
25. Click Database – complete  
26. Click OK 
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27. The restore process will begin.  When it is finished, Click OK. 
 

 
 

28. Done 
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Restoring a MSSQL 2005/2008 Backup  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup 
3. Select Search a specific location for a list of backups   
4. Click Next 
5. Click the SQL backup you’d like to restore 
 

 
 
 

6. Click Specify a location to restore to 
7. Type in or browse to the desired restore location (e.g. C:\temp) 
8. The SQL backup will be restored to the location you specified on the restore window  
9. Browse to the location specified by the restore window 
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10. Click Start > Programs > Microsoft SQL Server 2005 > SQL Server Management Studio 

11. Click to Connect to the desired Server  
 

 
 

 
12. Expand Databases  
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13. Right Click the desired database and Click Task > Restore > Database 
 

 
 
 

14. Under Source for Restore Click From device  
 

 
 

15. Click the browse button (…)     
 

16. Click the Add button  



                                      IV-Client Guide  
 

VaultLogix IV-Client Guide 
Generated on: 1/22/2010 55 

 
 

17. Browse to the location of the restored database file(s)  
 
NOTE: If using THIN Differential to backup MSSQL, you will have to select two files to import.  The 
file extensions will be .bak and _diff.bak.  
 

 
 
 

18. Click OK > OK  
19. Click on the check box under Restore and Click OK 
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20.  Done  
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Restoring a Full MS Exchange Database  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup 
3. Select Restoring - Search a Specific location for a list of backups 
4. Click Next 
5. Select the MS Exchange Backup that you’d like to restore  
6. Click Restore to the location that the files were backed up from 

 

 
 

7. Select ALL the files in the backup and Click Next   
 

 
 

8. The Restore will proceed as normal 
9. Done 

 
NOTE: The IV-Client must be on the same server as the MS Exchange server at the time of restore    
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Restoring a Mailbox Level MS Exchange Backup  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup 
3. Select Restoring - Search a Specific location for a list of backups 
4. Click Next 
5. Select the MS Exchange Mail Level Backup (Brick level) that you’d like to restore  

 

 
 

6. Select ALL the files in the backup and Click Next   
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7. The Restore will proceed as normal (see Restoring a Full MS Exchange Database)  
 
NOTE: The IV-Client must be on the same server as the MS Exchange server if restoring to the 
original location (Overwriting the current MS Exchange files)    
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Restoring System State  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Restore Backup 
3. Select Restoring - Search a Specific location for a list of backups 
4. See VaultLogix’s online FAQ for specific instruction as it is specific per O/S 
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Restoring Active Directory on Windows 2003 or above 
1. Restart the machine and enter the boot menu (Most commonly entered by clicking the F8 key)   
2. Select the Active Directory safe mode boot option  
3. Once entered into Windows safe mode, open the IV-Client and restore like usual (see 

Restoring- Search a Specific Location for a List Known Backups)  
 
 
NOTE: See VaultLogix’s online FAQ for specific instruction as it is specific per O/S 
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Restoring a FTP/SFTP/FTPS Backup (Windows, MAC, Linux, etc…)  
 

1. Proceed with the restore as normal (see Restoring - Search a Specific location for a list of 
backups) 

2. Important: Select Specify a location to restore to: as the Restore to the location that the 
files were backed up from is NOT valid for FTP/SFTP/FTPS backups.   

 

 
 

3. Proceed with the rest of the restore as normal (see Restoring - Search a Specific location for 
a list of backups)  

4. Manually move the restored data from the source, the specified restore location, to the 
destination drive, the machine that you’re restoring. 

5. Done  
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Restoring from Local Storage  
Local storage allows you to keep a local copy of your data onsite for faster restore times in non critical 
situations.  The Local Restore option is available on the backup server selection screen (see Running a 
Backup to Local Storage)  
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click Restore Backup 
3. Click Restore from Local Storage  
4. Select the files/folders to restore and proceed with the restore as usual (see Restoring - 

Search a Specific location for a list of backups) 
5. Done 
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Restoring from the Web (Customer Management Console) 
 
See the Customer Management Console section of this document for all details including how to 
restore using your web browser.  
 
 

Restoring using Command Line Parameters  
For more information on using Command Line Parameters for Restore, please see our Frequently Asked 
Questions section in your VaultLogix Customer Portal.  
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Customer Management Console  
The customer Management Console is your personal management console used to view your backup 
stats, change personal information and even restore using a web browser from anywhere in the world.   

 

Accessing the Customer Management Console  
 
Your customer management console is accessed by navigating to a specific http path with your web 
browser.  This http path will be given to you by your server’s administrator and can be accessed using 
the same user name/password that you use to backup with.  
 

Restoring from the Customer Management Console (web)  
 

1. On the main page Click Backup/Restores > Backup Sets   
2. Choose the Profile Name and Click View Versions  
3. Now Click View Files  
4. Expand the tree to file that you’d like to restore  
5. Double Click the file on the right hand side of the screen  
6. Click Save as from the new dialogue window that will appear after the server has assembled 

the file   
7. Done  

 

Changing Your Account Information  
 

1. From the Customer Management Console Click Account > Account Information  
2. From here you can change your address and password etc…  
3. Done  
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Advanced Backup and Recovery 
 

Advanced Restore Options 
During the process of restoring backups, you are offered several optional advanced restore options. 

 
1. Proceed with the restore as normal until you get to the below screen (see Restoring - Search a 

Specific location for a list of backups) 
2. Click Advanced restore options 

 

 
 
>>Overwrite files that already exist: This option will replace all existing files with the new restored 
files.  
 
>>Skip files that already exist: This option will skip the restore of files that already exist at the restore 
location.    
 
>>Remove the first “x” levels of directories from each listed file: This option will remove “x” number 
of hierarchical levels from the restored files  
 
>>Pre-pend the following to every listed file: Pre-pending directory levels allows you to alter the path 
of the restore.  You can send it to another server or simply to another directory.  Combined with 
removing directory levels, you can change the path of restore files as needed.   
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Initial Large Backup to Local USB Disk 
When running a large backup for the first time, you may find it advantageous to first run your initial 
large backup to local USB storage and then ship the drive via courier to your offsite server’s 
administrator for him/her to import.  This will avoid bandwidth bottlenecks or having to span a large 
initial backup over multiple days. (see Spanning a Large Initial Backup)   
After completing the first time large initial backup to local storage, you’ll be free to continue running 
backups directly to the offsite server even if the administrator has not yet imported your data in.  
 

1) Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2) Click on Create a New Schedule 
3) Choose any file(s) and folder(s) to be backed up throughout your network  
4) At the server selection screen, Click Use initial exported backup for later import 
 

 
 
 
5) Browse to the backup location  
6) Click OK 
7) Proceed with the backup as normal 
8) Once the backup job is complete, send the drive via courier to your offsite server’s 

administrator so that he/she may import it directly into the offsite server  
9) Done  
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Spanning a Large Initial Backup   
The Spanning a large initial backup function is used to span an initial large amount of data over several 
days to avoid bandwidth slowdowns during peak operations times.   
 

1. Start > Programs > VaultLogix Internet Vault > VaultLogix Internet Vault 
2. Click on Create a New Schedule  
3. Choose any file(s) and folder(s) to be backed up throughout your network  
4. At the server selection screen below, input the number of minutes that you’d like to run the 

backup for.   
 
NOTE: In the example below, Spanning is set to (2hours).  After the 2 hours have expired, the backup 
will automatically stop and rerun where it left off on the schedule’s frequency. 
    

 
 
 

5. Continue with the backup as normal (see Creating a Backup Set) 
6. Done  
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Importing Data from an Emergency Restore  
 
In case of disaster, an organization’s restore window is usually very limited because time is money.  
Internet Vault helps solve this obstacle by eliminating the need of restoring large amounts of data over 
the wire by allowing the server administrator to export a user’s backup set(s) to a physical removable 
disk, which will then be shipped via courier service.   
 
NOTE: All data will remain encrypted, de-duped and compressed on disk until it is imported by the user 
with the VaultLogix IV-Client  
 

1. From the VaultLogix IV-Client, Click Tools> Restore from external media  
2. Select the location of the removable physical media and the restore location  
3. Enter in your username/password that is used to connect to the VaultLogix server 
4. Enter in the Customer and User Encryption Key(s) (optional)  
5. Click Restore  
6. Done 
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Reports and Logs  

 
Report Statuses  
Backup job was successful: This message reports that all files were successfully backed up.   
 
Backup job was successful with exceptions: This message reports that some files were skipped during 
the backup job.  The most common reason is that the files were either open, in-use or locked during 
the backup.  The avoid skipping files install the ROBO-fm open file add-on after installing the IV-Client.     
 
Backup job was cancelled: This message reports that the backup job was cancelled by the backup 
owner.   
 
 
Note: For a complete list of descriptions please see the VaultLogix knowledge base under your 
VaultLogix customer portal 
 
 
Viewing Reports Listed By Backup Job 
 

1. Click View list of reports by computer name 
2. Click the appropriate + sign to bring up the list of backup or restore reports you wish to view 
3. Proceed with displaying the report  

 
 

Enabling Client Side Logs  
 

1. From the main IV-Client landing window Click Preferences  
2. Click Log  
3. Choose the Logs to enable and you’re all set  
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Enabling Client Side XML Logs  
 
The built in XML notifications outputs all the files backed up with their respect modification dates. 
This can be used to parse out information about the backup and upload it to an external application. 
 

1. Open up the IV-Client  
2. On the report/log screen within the IV-Client Click on all the check boxes under XML 

Notifications  
3. Continue to complete the backup job creation as usual (See Creating a Backup Set)  
4. Done 
 
 

The XML notifications are stored at  
 
Windows 2000, 2003, XP: 
 
C:\Documents and Settings\All Users\Application Data\BackupClient\XMLReports 
 
Windows Vista, 7, 2008: 
 
C:\ProgramData\BackupClient\XMLReports 
 
 
 
 

 

 


